CAP 501

User’s Guide






1MRS751900-MUM
Issued: 02.12.2003
Version: K/07.02.2006

CAP 501

User’s Guide

Contents
1. About this manual ... 7
1.1, COPYIIGNES e 7
L I = To [T o= 7
1.3, GUAIANEEE ...t 7
L I 1= T - | PSPPI 7
1.5. USE Of SYMDOIS ...ovviiiiiiiiiiiiiiiiieeiieeeeeeeeeeeeee e e e e e e e 8
1.6. ADDreviations .............eeeiiiiiiiiiiiiiieeee e 8
1.7. Related dOCUMENES .......ooviiiiiiiiiieieeeeeeeee e 8
1.8. DOCUMENT FEVISIONS ....eeeiiiiiiiiiiiiiiiiiieeieeeeeeeeeeeee et 9
Introduction ... —— 1
2.1, GENEIAI . 11
2.2. Operational features ..........oeeeviiiiiiiiiiiiiiieiieeeeeeeeeeeee e 11
DG T U T o101 (=T = Lo Y 12
2.4, BASE SYSIEM ..o 12
2.5, APPLICAtIONS ..ovveieei e 12
2.6. CAP 501 t0O0IS ...ooeeeeeiiiiiieie et 12
. Quick start eXxample ... ——————— 15
3.1 PrOJECES o 15
3.2, VIBWS et 15
3.3. ODbJECLIYPES oovieeeieeeeeeeeeeeeeee 15
3.4. ODjJECt tyPe GrOUPS ....vviiiiiiiiiiiiie e 16
3.5. Starting CAP 501 ... 16
3.6. Insertion of Objects .........coovvviviiiiiii 16
3.7. Moving objects in the Project ..........ccccoviiiiiiiiiiieeeeee 23
3.8. System configuration ... 24
3.9. Configuration of device objects ..........cccccvviiiiiiiiiii 24
3.9.1. GENEIAl ..uuueiiiiieeeeee e, 24
3.9.2. Relay configuration procedure ..................cccccei. 25
3.9.2.1. RED 500 relay object types .......cccccevveeiiiiiinnnnnn. 25
3.9.2.2. SPACOM relay object types .......ccccceeeeviiirinnnnnn. 28
3.9.3. SUMMAIY oo 30
3.10.USING USEI VIEBWS .....oiiiiiiiiiiiiiiiiiee e 30
3.11.Launching object tools ..........ouvciiiiii i 32
. Project Structure Navigator ..........cccoeeiiemcccccccccccreee e 33
4.1, GENEIAI e 33
B e (o] [ PR 33
4.2.1. Master Design VIEW ... 33



CAP 501

1MRS751900-MUM

User’s Guide

4.2.2. USEIrVIEWS oooiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeee e 33
4.3. ODJECLLYPES ooveieiieiieeeeeeee et 34
4.4. ODbjJject type groUps ....ccoveviiiiiiiiiiiiieeeeeeeeeeeeeeeeeee e 34
4.5, Userinterface ......ooooveiiiiiiiiiiieiieeieeeeeeeeeeeeeee e 35
4.6. Entering the Project Structure Navigator ................c..cocccol. 36
A 1 1= 0 1T o U 36

471, File OPEN oo, 37

4.7.2. File ClOSE .covvieeeiiiieiee et 37

4.7.3. Organize Projects ... 37

4.7.4. File History List .......coovrriiiii e, 37

475, EXIt oo 37
4.8. Edit MENU ..oooiii e 38

4.8.1. INSert ODJECT ....cooiiiiiiiiiee e 38

4.8.2. Delete ObjecCt ..o, 40

4.8.3. Object Properties ........cccccooiiiiiiiiiiiiiiiieee e 41

4.8.3.1. General Object Attributes dialog .............euueeee.ee. 41
4.8.3.2. Moving Objects ........uueeeiiiiiiiie e, 43
4.9, VIEWS MENU ..oeviiiiiiiiiiiieiiieeee et eeee et ee et e e e e e e e e e e e e e e e e e e e eeaeaaaeaaaaaaaaaees 43

4.9.1. Create VIEW ....cooooiiiiiiieee et 44

4.9.2. Delete VIEW ..cooovviiiiiie . 45

4.9.3. VieW Properties ........ccccvvuiiiiiiii e 45

4.9.4. VIeW LiSt ..oooviiiiiieee e 45
4.10.System TOOIS MENU ....coiviiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeee e, 45

4.10.1.CUSTOMIZE... coiieeiieee e 46
g I A o = T T 0 4T o T PP 46

4.11.1.About Project Structure Navigator .................................. 46

4.11.2.About CAP 501 ...ooeiiiiiiiee et 47

. Project Export/Import TOOI ........cccviiimiimnmeeeemeensnssssssseennns 49
5.1, GeNEIal coooveeeeeieeee 49
5.2. Starting the Project Export/Import TOO!l ... 49
5.3. Features ... 50

5.3.1. Updating the project list .........cccccoriiiiiiiiiiiee, 50

5.3.2. Project storage .....ccccovviviiiiiiiiiiiiei e, 51

5.3.3. Copying projects between network computers ................ 52

5.3.4. Choosing storage location for temporary projects ........... 53

5.3.5. EXporting Projects .........occcuveieiiiiiiiiiiiieeeeee e 53

5.3.6. Importing Projects ........coovviriiiiiiiii e 54

5.3.7. Project properties .........ccoceeeeeiiiii 55

5.3.8. Deleting a project .........cooovrrieiiiiii e, 56

5.3.9. Duplicating @ project ........cccueeeiiiiiiiiiiieeee e 56



1MRS751900-MUM CAP 501
User’s Guide

5.3.10.Creating @ New project ..........ccccveeeriiiiiiiieeeeee e 56
5.3.11.Errors accessing remote disk resources ............cccccevvennn. 57

6. Plant Structure Settings ..o 59
B.1. GENEIAI ... 59
6.2. Starting the Plant Structure Settings Tool ........................l. 59
6.3. Attributes of plant structures ..........cccccciiiiiiiiiiic e, 59
6.3.1. LeVel Id ..o 60

6.3.2. Level Description .......ccovvviiiiiiiii 60

6.3.3. Field Length ......c.ooeeiiiiiii e 60

7. Plant Structure object types .....ccccccceccecciiiiiiie s 61
T4 OVEIVIEW ..eeiiiiieiee e ettt ettt e e e e e e et e e e e e e s e nnnnneeeeeeeeeanns 61
7.2, GENEIAI ... 61
7.3. Field 1ength ... 61
T4, STAtION e 61
7.5, BaAY i 63
8. User Structure object types .....cccccccccciiiiiiiiiiii e, 65
8.1, OVEIVIEBW ...ttt e e e s e e e e e e e e eanns 65
I 1Y 1= - | 65
8.2.1. Inserting Level objects ........cccceeiiiiiiiii . 65

9. Gateway object types (COM 610) .........cccceeviiviirirrrerreeerceennnnns 67
S R € 7= o1 - | SRR 67
9.2. Supported protocols .........ooceeviiiiiiii 67
9.3. INSEILION cooieiieeieeeeeeee e 68
9.4. Communication SettiNgS .........ccccuvviiiiiiiiii e 68
9.4.1. Communication settings of COM 610 object .................... 69
9.4.1.1. SPA protocol settings of COM 610 object .......... 69

9.4.1.2. SPA TCP/IP protocol settings of COM 610

ODJECT ..o 69

9.4.2. Communication settings of device object ........................ 70

9.5. Using COM 610 ODJECE .....ccooiiiiiiiiieieeeeeiee e 71
10.System Configuration TOOol .......ccccccvmmmmmmmimmi s 73
LR =T 1= = 73
10.2.Target ProjECt .....uoii i 73
10.3.Communication protocol SUPPOrt ...........eeeeeeeveeeiveeeerieeireeeeeeeeeeeee, 73
10.4.Serial port configuration ...........cccooiiiiiiii 73
10.4.1.8€rial POIS oovviiiiiiieieeeeeeeeee 73
10.4.2.Advanced serial port settings ........cccccoviiiiiiiiiiiiiinie, 73
10.4.3.Basic serial port settings .........coovvvvviiiiiii 74
10.4.4.Using USB POrtS ......ouviiiiiiiiiiiiiieieeeeeeeeee e 74
10.5.SPA TCP/IP communication ...........cceeveeeeiiiiiiiiiieeee e 74



CAP 501 1MRS751900-MUM

User’s Guide

10.6.S1ArING oo 74
10.7.System Configuration Tool dialog ..........ccccuvmieiiiiiiiiiiiiiiieeeeees 75
10.7.1.Serial POrts page ......ocovveiviiiiiiiiiieieeeeeeeeeeeeeeeeeeeeeeeee e 76
10.7.1.1.Serial ports - AddiNg ......cevveeieeiiiiiiiiieieeeeeee 77
10.7.1.2.Serial ports - Configuring .........ccccccvvvvvivivinnnnnnnns 78
10.7.1.3.Serial ports - Deleting .......ccccoeeiiiiiiiiiii, 79
10.7.2.SPA TCP/IP PAGE ...tvvveiieeeeiiiiieeeeee e 80
10.7.2.1.TCP connections - Adding .......cccceeveeiiiiiiciiinnnnnns 81
10.7.2.2.TCP connections - Configuring .........cc.cccceeuueuee. 81
10.7.2.3.TCP connections - Deleting ..........cccccceeeeiiinnnnnn. 82
10.8.System configuration - SAVe ..........ceeeveeeiiiiiiiiiiiiiieeeeeeeeeeeeeeeee 83
10.8.1.Save configuration - close tool .........ccccccevviiviiiii. 83
10.8.2.Save configuration - proceed configuration .................... 83
10.8.3.Discard configuration changes ..........ccccceeeeiiiiiiiiiieennnn. 84
10.9.Resetting communication settings .......ccccoooeviiriiiiiiii 84
T 1T [ 85



1MRS751900-MUM

CAP 501

User’s Guide

1.1.

1.2

1.3.

1.4.

About this manual

Copyrights

The information in this document is subject to change without notice and should not
be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for
any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or
consequential damages of any nature or kind arising from the use of this document,
nor shall ABB Oy be liable for incidental or consequential damages arising from use
of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written
permission from ABB Oy, and the contents thereof must not be imparted to a third
party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license
and may be used, copied, or disclosed only in accordance with the terms of such
license.

Copyright © 2006 ABB Oy
All rights reserved.

Trademarks

ABB is a registered trademark of ABB Group. All other brand or product names
mentioned in this document may be trademarks or registered trademarks of their
respective holders.

Guarantee

Please inquire about the terms of guarantee from your nearest ABB representative.

General

This manual provides thorough information on the CAP 501, Relay Setting Tools
software and its applications. This document complies with the CAP 501 version
2.4.0.

Pictures shown are examples only and they may represent older program versions.

Additional information such as the Release Note and README.TXT can be found
on the program distribution media.

ABB Oy regularly provides standard training courses on its main products. The
training program is available on the Internet at
http://www.abb.com/substationautomation. Please contact your ABB representative
for more information
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1.5.

1.6.

1.7.

Use of symbols

This publication includes warning, caution, and information icons that point out
safety related conditions or other important information. It also includes tip icons to
point out useful information to the reader. The corresponding icons should be
interpreted as follows:

to the concept discussed in the text. It might indicate the presence of
a hazard which could result in corruption of software or damage to
equipment or property.

@ The caution icon indicates important information or warning related

The information icon alerts the reader to relevant facts and
ﬂ conditions.

The tip icon indicates advice on, for example, how to design your
Q project or how to use a certain function.

Although warning hazards are related to personal injury, and caution hazards are
associated with equipment or property damage, it should be understood that
operation of damaged equipment could, under certain operational conditions, result
in degraded process performance leading to personal injury or death. Therefore,
comply fully with all warning and caution notices.

Abbreviations

HSB Hot Stand-By

HSI Human System Interface

IRQ Interrupt request line

SPA Data communication protocol developed by ABB

UNC Universal Naming Convention

TCP/IP Transport Control Protocol/ Internet Protocol; de facto
communication protocol standard for data transmission over
networks

Related documents

Name of the manual Document ID

CAP 501 Installation and Commissioning 1MRS751899-MUM

LIB, CAP and SMS, Tools for Relays and Terminals,

User's Guide 1MRS752008-MUM
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1.8.

Document revisions

Version SW Revision number Date History

F 2.3.0 12.12.2003 Windows XP updates
Using USB ports
STA object amount updated

G 2.3.0-4 05.01.2005 Maintenance updates
H 2.3.0-5 01.03.2005 Event Log Viewer
K 240 07.02.2006 -SPA TCP/IP protocol added

-New chapter “Gateway object
types (COM 610)”
-Maintenance updates
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2.1.

2.2,

Introduction

About this chapter

This chapter introduces CAP 501, its base system, operational features, user
interface and functional description.

General

CAP 501, the Relay Setting Tools software, is a Computer Aided Programming
system for medium voltage relays in the RED 500 and SPACOM series.

CAP 501 provides you with the following tools:

* The Project Structure Navigator for handling relays and tools.
* The RED Relay Setting Tool for parametrization of RED 500 series of relays.

* Graphical I/O Setting Tool for setting I/O related parameters of the REX 521
relays.

* The SPACOM Relay Setting Tool for parametrization of SPACOM series of
relays.

* The Project Export/Import Tool for project management.

* The Communication Configuration page for setting communication parameters
of the device objects.

* The Disturbance Recorder Collector Tool for uploading of disturbance records
from the RED 500 series of relays.

» The System Configuration Tool for configuring the projects' system
configuration.

* Event Log Viewer for uploading and viewing event logs from the RED 500
terminals.

CAP 501 is mainly used as a local system near the relay. Communication with the
relays is mainly done through the relay’s front panel connector or in case of the SPA
TCP/IP protocol through the rear connector.

Operational features
This is a summary of functions provided by CAP 501 provides:

* On-line and off-line parametrization

* Framework for relay tools

* Project management

* Object oriented project data management
* Loading of parameters to the relay

» Loading of parameters from the relay

* Loading of recorded values from the relay

11
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2.5.

2.6.
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+ Edit history of parameters
» Comparison of present and saved values
* Uploading of disturbance records from the relay

* Uploading of event logs

User interface
The user interface of the CAP 501 system consists of the following components:

* Project Structure Navigator for tool selection and object management

* Project Export/Import Tool for archiving and transfering projects

Base system
The CAP 501 system contains a base system and a communications system.
Supported communication protocols are:

* SPA, through serial ports to relay's front or rear panel interface

* SPA TCP/IP, through Ethernet adapters to relay's rear panel interface

Applications

CAP 501 provides tools for parametrization and disturbance record upload from
protection relays in the RED 500 and SPACOM series.

CAP 501 tools

Project Export/Import Tool

The Project Export/Import Tool is used for project management purposes like
deletion, duplication, and creation of projects. In addition to this, the tool is used
when a project is to be transferred to another system or brought into the current
collection of projects.

This tool is documented in Chapter 5. Project Export/Import Tool.

Relay Setting Tool

The Relay Setting Tool is used for parameterizing the protection relays. The
parameters can be set off-line in a PC and downloaded to the relay or uploaded from
the relay over a communication port.

The Relay Setting Tool menu structure including views for parameterization are the
same as the views on the technical level of the local HSI (Human System Interface)
for the relays in the RED 500 series.

It is also possible to set parameters in relays in the SPACOM series.

The Relay Setting Tools for RED 500 and SPACOM are documented in the 7oo0ls
for Relays and Terminals manual.
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Graphical 1/0 Setting Tool

The Graphical 1/0 Setting Tool is used for graphical setting of digital inputs, digital
outputs and alarm LED signals of the REX 521 relays. These 1/O related parameters
can be set off-line in a PC, and downloaded to the relay or uploaded from the relay.

The Graphical I/0 Setting Tool is complementary to the RED Relay Setting Tool; a
change of parameter setting in the Graphical I/O Setting Tool will be visible in the
RED Relay Setting Tool, and vice versa.

This tool is documented in the Tools for Relays and Terminals manual.

System Configuration Tool

The System Configuration Tool is used for configuring the projects' system
configuration to enable communication with the relays.

This tool is documented in Chapter 10. System Configuration Tool.

Disturbance Recorder Collector Tool

With the DR-Collector Tool, disturbance records can be uploaded from the RED 500
and SPACOM series of relays. The supported recording file format is COMTRADE.

This tool is documented in the Tools for Relays and Terminals manual.

Event Log Viewer

The Event Log Viewer is used for uploading and viewing event logs from the RED
500 terminals. An event log is a snapshot of the current events in the event view of
the connected terminal.

This tool is documented in the Tools for Relays and Terminals manual.

13
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3.1.

3.2.

3.3.

Quick start example

About this chapter

This chapter discusses the basic steps for getting started with CAP 501 and is
intended to serve as an introductory reading to users not familiar with CAP 501.

The quick start example:

* Guides you through the process of constructing a representation of a simple
station with three bays with RED 500 and SPACOM relays, familiarizing you
with basic functions such as adding, configuring and moving objects in a project.

* [llustrates one solution to organize the project by means of user views.

Projects

CAP 501 supplies an initial empty project titled SOST. Initially, the SOST project
is set as the default project, meaning that this project will contain the new objects
unless another project is explicitly created and opened, using the Project Export/
Import Tool. For detailed information on working with CAP 501 projects, see
Chapter 5. Project Export/Import Tool.

Views

The Project Structure Navigator provides the possibility to define different view
contexts. This feature makes it possible to group the inserted objects arbitrarily,
which is a useful feature when the number of inserted objects is large. For detailed
information on working with project views, see Section 4.9. Views menu.

Object types

There are three main categories of object types, i.e. level object types, device object
types and compound object types.

The level object types are used for building the structure of the projects and their
views.

The device object types are used when a physical device shall be used. For example,
REF54x is a device object type.

Compound object types combine the behaviour of both the level and device object
types. In essence, compound object types participate in a project's structurization but
they also have configurable properties, similar to the device object types. For
instance, you can use Station and Bay objects to build a representation of a station
and its bays.

15
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Object type groups

Each object type belongs to one named object type group, which provides similar
functionality.

Four object type groups are available:
User Structure Object types of this group serve the purpose of project
structurization.

Gateway Object types of this group serve the purpose of project
structurization and representation of communication
gateway devices.

Plant Structure Object types of this group serve the purpose of project
structurization.

Protection & Control Object types of this group serve the purpose of
representing protection and control devices.

Starting CAP 501

To start CAP 501, select the Start CAP 501 icon from the program folder created by
the CAP 501 installation program. The Project Structure Navigator with the default
project opened in the Master Design View mode appears.

Insertion of objects

In this section, begin by inserting four RED 500 device objects and one SPACOM
device object to the project. Then, add a simple representation of a station with three
bays.

Device object insertion

At this point, your project contains only the abstract root node, which is titled 'Root'.
Click on the root node with the mouse, so the navigator knows where to insert the
new object in the project structure. Next, choose Insert Object on the navigator's Edit
menu, after which the Add Project Object dialog appears on the screen.

B Add Project Object X
Object type groups: Object types:
I1zer Structure
Plant Structure
3 ateway
Pratection & Cantral
= =
ok || ciese |

qgs1_1

Fig. 3.6.-1 Adding a new object to the project
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This dialog displays the object type groups and the object types present in the
system. As you are now inserting a device object, the interest group is Protection &
Control, which groups the RED 500 series and SPACOM series object types.

To insert a device object representing a REF54x relay terminal of the RED 500 relay
series, click on the Protection & Control list item. As the result, you are viewing the
list of Protection & Control object types. The first available object type is
automatically selected, as shown in Fig. 3.6.-2.

B Add Project Object X]
Object type aroups: Object types:
Izer Structure REF54x% - REF 541,/543/545 Feeder Terminal

Flant Structure REMS4x - REM 543/545 Machine Terminal
RETH4= - RET 541,/543/545 Transfarmer Ten
RECEZx - REC 523 Remate Monitanng and Cr
RE#E52w - REX 521 Protection Relay

REJSusx - REJ 51_/52_ Mulki-Purpose Protect
REU 5 - REL 513/523 Combined Owvervolta
RE«E1x - REM/REF/REL E10 Protection Rel,
3 SPACORK - SPACOK Product Family

0K, Close |

add_proj_obj_1
Fig. 3.6.-2 Selecting the type of the object
The appropriate object type (REF54x) is already selected. To insert it, click OK,

which opens the New Object's Properties dialog for entering the object's name and
title.

Mew Object's Properties [_ |O]
Object Mame:
| INCOMERH

Object Title:
| |hzomer protection and control

ak | Cancel

nop. tif

Fig. 3.6.-3 Entering the name and title for the object

17
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Type in the name and title and click OK. The dialog closes and the object is inserted
under the root node. The object's title is displayed in the project views. Now your
project should look like the one shown in Fig. 3.6.-4.

B CAP 501 - Master Design View M=
Eile Edit “iews Sypstem Toolz Help

&K ||
Project Structure Object Toolz

b-oo : B

L]

| CACAPSOTPRIA | A

qs3_1

Fig. 3.6.-4 The inserted REF54x device object in the project's view

Repeat this insertion procedure twice, specifying ‘OUT1’ and ‘OUT2’ as the names
and '"Protection and control' as the title for both of the objects. These new REF54x
objects will also be inserted under the project's root node, since the project does not
yet contain any compound objects being able to host the device objects. Your project
should now look like the one shown in Fig. 3.6.-5.

B CAP 501 - Master Design View H(=1E3

File Edit “iews Suvztem Toolz Help

Project Structure Cbject Tools

=T : B

]

| CACAPSOTYPRIN | A

qs4_1

Fig. 3.6.-5 Three REF54x device objects in the project

Now you have three REF54x device objects in the project. As you may recall, the
aim is to insert also a device object of the SPACOM type.
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To accomplish this, repeat the insertion procedure with the exception: select the
SPACOM object type from the Protection & Control group. For the object's name
and title, specify INCOMER?2', 'Differential protection'. When you are ready, the
project should look like the one shown in Fig. 3.6.-6.

B CAP 501 - Master Design View M=

Eile Edit “iews System Toolz Help

Project Structure Object Toolz

= z -]

B |ncomer protection and control

® Protection and contral

B Protection and control

~ " Differential protection

]

C:ACAPS0TAPRIN i“i““

qgs5_1
Fig. 3.6.-6 Four device objects in the project's view
Notice that, in terms of usability, these newly inserted device objects are somewhat
abstract, since they lack essential information about the physical relay terminals they

represent. In practice, these objects need to be configured before they can be used
(the configuration procedure is explained later).

As you now have some device objects, you can advance to add compound objects to
the project to organize the contents of the project.

Compound object insertion - Plant Structure
Next, you will build a simple representation of a station with three bays.

Start by selecting the project's root node that will be the insert-location for the
Station object. In fact, the only location where you can insert a Station object is the
project's root node.

In the Edit menu, choose Insert Object to bring up the Add Project Object dialog.
Since the Station object type belongs to the Plant Structure group, select the Plant
Structure group as shown in Fig. 3.6.-7.

19
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B Add Project Object (%]

Object type groups: Object types:

Idzer Structure

3 ateway
Pratection & Cantral

ok || ciese |

Fig. 3.6.-7 Selecting a Station object

qs6_1

To have the Station object inserted, click OK. The dialog which now appears for
entering attributes for the object, is specific for insertion of Plant Structure objects,
as illustrated in Fig. 3.6.-8. Enter 'Eastwick’ as the object's title and 'STA1' as its

name.

Add Plant Structure Object - Station

FParent Object; | Root

Plant Structure Object |

Obiject Name: The maxirurm nurnber of characters for the
| STA object name iz 10

Object Title:
| E ashwick

0k, Caricel
qz/ hif

Fig. 3.6.-8 Inserting a Plant Structure object - Station

Click OK to insert the station object. Now your project should look like the one in

Fig. 3.6.-9.
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B CAP 501 - Master Design View
File Edit “iews Suvztem Toolz Help

Project Structure Object Tools

| : o]

i leferentlal pratectian > EI

| CACAPSOTYPRIA | Al

qs8_1

Fig. 3.6.-9 The new Station object in the project's view

Now you have a Station object capable of hosting the bays. Next, you will insert
three Bay objects under the station. Eventually, the project's device objects will be
moved under these bays.

As the station will be the parent for the bays, select the Station object to set the
correct insert-location.

Invoke the Add Project Object dialog. The navigator is aware of the currently
selected object's type (Station) and displays the available object groups and types
accordingly (see Fig. 3.6.-10).

B Add Project Object [X]

Object type groups: Object types:

Flant Structure

] #]
(3 ateway I I
E2 #

ok || clese |

gs9_1

Fig. 3.6.-10 Selecting the Bay object type
To insert the object, click OK and specify the name and title as in Fig. 3.6.-11.

21
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Add Plant Structure Object - Bay

Parent Object; | 0BJ0005

Plant Structure Object |

Obiject Name: The maxirmum nurmber of characters for the
| Bay object name iz 15

Object Title:
| | nizoming

0k, Cancel

=1 0. kif

Fig. 3.6.-11 Specifying the name and title for the Bay object

Next, add two bays similarly, specifying 'Bay?2', 'Bay3' and 'Outgoing 1', 'Outgoing
2" as their names and titles. Now your project should look like the one shown in
Fig. 3.6.-12.

B CAP 501 - Master Design View

Eile Edit “iews System Toolz Help

& J:%Ix%l

Project Structure

Object Toolz

-0
= |ncoming
= Outgoing 1

= Outgoing 2
— & |ncomer protection and control

B Protection and control
— B Protection and control

— " Differential pratection

=

-1
| CACAPSOTYPRIA | OI

gs11_1
Fig. 3.6.-12 The station hosting three bays

Now you are ready to organize the project further by moving the device objects to
more appropriate locations in the project structure.
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3.7.

Moving objects in the project

In this section, the existing device objects are moved to a new location in the project
structure.

Fig. 3.7.-1 illustrates the intended final organization of the device objects in the
Master Design View.

B CAP 501 - Master Design View Mi=1E3

File Edit Yiews

Project Structure Object Toolz
%M * B
= Easbwick
= |ncoming
|:' |ncomer protection and control

Syztem Tool:  Help

~ " Differential protection

= Outgoing 1
L B Protection and control
= Outgoing 2
L B Protection and control 3 3'
| CACAPSOT\PRIAGSTA | A

gs12_1

Fig. 3.7.-1 Objects in their final locations

The procedure for moving objects in the project's views consists of the following
steps:

1. Select the object you intend to move by clicking on it with the mouse.

2. On the Project Structure Navigator's Edit menu, select the Object Properties to
bring up the General Object Attributes dialog.

3. Click Move on the General Object Attributes dialog to bring up the Move
Object dialog.

4. From the project structure, select the target compound object, which will host
the moved object.

5. Click Move Here on the Move Object dialog to move the object to the selected
target location.

Following this procedure, move the objects one at a time to the locations shown in
Fig. 3.7.-1. Notice that moving a device object under a bay object, causes the station
node to collapse. A collapsed node is expanded by either double-clicking on it or by
clicking on the plus sign (+) on the node's left hand side.
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System configuration

The system communication should also be configured at some point. It has to be
done before you configure the communication settings on device (relay) level, see
Fig. 3.9.2.2.-3. You need to make the basic communication definitions for the serial
ports. From the System Tools menu, select item System Configuration and page
Communication, see Fig. 3.8.-1.

"2 system Configuration

Communication |

K

Senal Ports

Cancel

Apply

Delete ..

Praotocal;

Connection Type:

toderm Cormand (ST ];

Drata Bits:

Parity:

[ [ [ =] I

|
|
Baud R ate: |
|
|
|

Stop Bitz:

| Bezet Communication Settingz I

sysenf tif

Fig. 3.8.-1 Setting up the serial ports

Use the Add button to add serial port. Usually the default settings are sufficient.
Press OK to save and to exit

Next, we will advance by configuring the project's device objects.

Configuration of device objects

General

Before using an inserted device object, the object must be configured. Otherwise,
attempts to launch an object tool result in notifications requesting you to configure
the object.

For instance, configuring a REF54x device object means that the object is assigned:

1. The software configuration (SW), which is a set of hardware dependent files.
The software configurations are supplied solely by ABB.
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3.9.21.

2. The application (Apl) configuration, which is a set of application dependent
files. An application configuration is either supplied by ABB or created within
the CAP 501/505 environment, which is why it has been saved into the
application library of the object’s object type.

Relay configuration procedure

A device object is configured in the Master Design View by means of a dialog,
which is dependent on the device object's type. The configuration procedure
comprises the following steps:

1. Select the device object in the project structure.

2. Select Object Properties on the Edit menu to open the General Object Attributes
dialog for the object, or press <Alt>+<Enter> on the keyboard. You can use the
Properties button as well, see Fig. 3.9.2.-1.

Fig. 3.9.2.-1  The Properties button

3. Click Attributes to open the object’s configuration dialog, see Figure 2.8.2.-2.

General Object Attributes M= E3

General | Communication | ok
Object Title: Object Mame: | Cancel I
| Incomer protection and control | IMCOMER
Object Tope: Yergion: Eroup: | Attributes...
| REF54x 1.36 | Protection & Contral | T |
Remark.z: =
+*
+

qoa.hif

Fig. 3.9.2.-2  General page for INCOMERI

RED 500 relay object types

1. Inthe SW library, select the SW configuration that matches the relay terminal
that shall be used.

2. Select an application in the Apl library, or if the application is unknown, some
of the RED object types allow uploading of the configuration from the relay
terminal. The uploaded configuration is available for selection in the Apl library
list.
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Close the object's configuration dialog by clicking OK to return to the General
Object Attributes dialog. For more information on configuring device objects, see
the Tools for Relays and Terminals manual.

Configuring the quick start device objects

To proceed with the sample, you need to configure the device objects in the order
they appear in the project. Once you are done, the objects are configured as shown
in Table 3.9.-1.

To proceed, select the device object INCOMER1 which is titled ‘Incomer protection
and control.” On the Edit menu, select Object Properties to bring up the General
Object Attributes dialog. The tabbed page titled General is active, displaying general
information on the object. Notice that on this dialog you can change some of the
object's attributes in the Master Design View. Which attributes are changeable,
depends on the object's type.

To configure the REF54x device, click Attributes and you enter the REF 54x
Configuration dialog (shown in Fig. 3.9.2.1.-1).

¥ Incomer protection and control - REF54x € o ] 5

REF54x Config

Transducers I About REF5Sd: |

]
=

— 5% configuration
|nstalled configuration
S library: Fiew:

|REF541-1MAS118500 [#] [E |#] [ Select New

Add-on protocol:
|<None zelecteds |£I

Dezcription
&, Sw configuration for REFS41 Arelease 3.0

— Apl configuration

|nstalled configuration

Apl libran: Rew:
[ 1MRS5114500 [#] [~ [#] B Select Mew
Dezcription

A empty application.

qs13

Fig. 3.9.2.1.-1 The configuration dialog for REF54x device objects
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Assigning the software configuration

As stated in Table 3.9.-1, this object's software configuration should be REF543-
IMRS118501 rev. F, thus the software configuration suggested by default, has to be
changed. In the dialog's upper area, the Select New check box is checked, allowing
you to select the appropriate software configuration.

To change the configuration, select the configuration named REF543-1MRS118501
from the list titled SW library and select revision F from the list titled Rev.

Assigning the application configuration

To complete this object's configuration, you need to assign the intended application
configuration for the object, in this sample it is IMRS114502 revision A.

To assign it, select the application configuration IMRS114502 from the list titled
Apl library and the revision A from the list titled Rev. Next, click OK to apply the
configuration, saving it to the project database. Now you returned to the General
Object Attributes dialog, close it by clicking OK.

Uploaded application configurations in REF54x, REM54x, REC52x and
RET 54x object types

The REF54x, REM54x, REC52x and RET 54x object types provide an alternative
of using an application configuration, which you can uploaded from the relay
terminal. Upon completion of the upload, you save the uploaded configuration into
the object type's user application library. These application configurations are stored
without revision information and are available through the Apl library list, shown in
Fig. 3.9.2.1.-1. The use of uploaded application configurations is outlined below:

1. Insert the device object to the project.

2. Configure the object as explained above, assigning an empty application
configuration, eventually you will replace it with the uploaded configuration.
Apply the configuration normally and then return to the Project Structure
Navigator.

3. Open the General Object Attributes dialog selecting the Communication page to
provide communication settings for the object. Select the communication
protocol and enter the value for the SPA address. Connect the communication
cable, if it has not been done yet.

4. Reopen the object type's configuration dialog. Click Apl Utils... and you enter
the dialog for maintaining the user application library.

5. By clicking Receive, the upload starts bringing up a progress indicator dialog.
Upon completion of the upload, you provide the name for the uploaded
configuration. This name will appear in the Apl library list.

6. Close the user application library management dialog by clicking Close. Now,
to assign the newly uploaded application configuration, check the Select New
check box and select the configuration from the Apl library list.

7. Close the object type's configuration dialog by clicking OK. You are prompted
to confirm the replacement of the application configuration. Click Yes to
enforce the new configuration.

To proceed with the sample, configure the other two REF54x device objects (OUT1
and OUT2) using Table 3.9.-1 as reference.
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SPACOM relay object types

At this point, the SPACOM device object INCOMER?) is still not configured. To
configure it, enter the object's configuration dialog as you did with the REF54x
objects. The configuration dialog that appears on the screen, differs from the one you
used for the REF54x objects (see Fig. 3.9.2.2.-1).

FE INCOMER?2 - SPACOM configuration

Hack Conhguration

Transducers I.-'l‘-.l:u:uutSF'.ﬁ.I:ElM I

qz14.tif

Types:

Complete Racks

E

Madules:

REC 501
SACO0 14504
SACO 18a3
SAC0 16D
SACO1EDZ
SACO1ED3
SAC0 6404
SPAA 120

SR&A 12
SP&A AN

4]

<-- Remove

R elay Dezcription;

R ack:

+

Qk Cancel I

Fig. 3.9.2.2.-1 The configuration dialog for SPACOM device objects

Now, locate the module named SPAD 346 from the Modules list and click Add —>
when you have selected the module. The dialog should look like the one shown in

Fig. 3.9.2.2.-2.
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5Z INCOMER?2 - SPACOM configuration !EI
) ) =15 kif
Rack Configuration | Tranzducers I.-'l‘-.l:u:uutSF'.ﬁ.I:ElM I
Types: R elay Dezcription;
Complete Packs E | SPAD 245
Modules: R ack:
SPAD 330 + SPCD 2053 +
SPAD 346 SPCD 2055
SPAD 346 C1 SPC) 4028
SPAD 346 C2
SPAD 346 C3
SPAF 340 C3
SPAG 310
SPAG 320
CRAR 2 * bt
Qk Cancel I

Fig. 3.9.2.2.-2 The selected SPACOM configuration

To apply the configuration, click OK and you return to the General Object Attributes
dialog.

Before you can make the communication setup for the individual objects, you have
to set up the system configuration as described in Section 3.8. System configuration
Alternatively, you can click the System Configuration button in the General Object
Attributes dialog (see Fig. 3.9.2.2.-3), which brings up the System Configuration
dialog (see Fig. 3.8.-1).

General Object Attributes

x|

General |Enmmunicatiun|
Protocols
| SPA, EI Syztemn Configuration
'
EX E

Inztalled modules Module addreszes

SPCD 3053 SPA Address: 13

SPCD 2055

ComSetup.tif

Fig. 3.9.2.2.-3 Communication addresses for some modules using SPA protocol

After having configured the system, you can make the communication setup for the
devices. The presentation may vary depending on the selected device.
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For example, the following devices with the following configuration have been
added to the project:
Table 3.9.-1 Example device configuration
REF54x device SW Configuration Apl Configuration
INCOMER1 REF543-1MRS118501 rev. F 1MRS114502 rev. A
OuUT1 REF541-1MRS118500 rev. C 1MRS114501 rev. A
OouT2 REF541-1MRS118500 rev. C 1MRS114501 rev. A
SPACOM device Relay Description
INCOMER2 SPAD 346
At this stage, you have almost completed the example. Next, you can familiarize
yourself with the use of user views in projects. Remember that regarding views, this
project contains only the Master Design View, which is the only view allowing you
to insert device objects to the project and configure them.
3.10. Using user views

30

General

No specific rules for the use of user views exist in regard to their logical contents or
amount.

Creating user views

In this example, you will create two rather self-explanatory user views: one named
Outgoing and another named Incoming. You will also populate these views with the
previously inserted device objects appropriately.

To proceed building the sample project, select Create view on the Views menu of
the Project Structure Navigator. This opens the Project View Properties dialog
shown in Fig. 3.10.-1.

B Project View Properties @

Praject view file name: | CACAPSOTAPRJAVDSTARTYORB. 00001 0VUIE QK

Project view name: | |ncoming Cancel I

Project view description: | Irizoming

Root name: | Incoming

Project view colos: ® Default color ) Dwn color: Il

qs16_

Fig. 3.10.-1 Entering information for the new user view
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Specify the information for the view as shown in the above figure. You can later
change these properties of views, by selecting the View Properties menu item on the
Views menu. Click OK to create the view. The Navigator opens the view
immediately. Notice that the Views menu now contains this newly added view
below the Master Design View menu item.

Next, add the other user view similarly and specify Outgoing for the view's
properties. Now your Views menu should contain the menu items shown in
Fig. 3.10.-2.

lete Wiew
Wiew Properties

Mazter Design Wiew
[nzoming
Cutgoing

Fig. 3.10.-2 User view menu items in place
Adding objects to a user view
Final step of this example is to populate the user views with the device objects.

The procedure for adding objects to user views is simplified compared to Master
Design View, since the objects have already been assigned names and other basic
information.

If the Outgoing view is not currently active, activate it by selecting the Outgoing
menu item on the Views menu. Now, select Insert Object on the Edit menu to bring
up the Add object from Master Design View dialog (see Fig. 3.10.-3). The dialog
lists all the device objects that exist in the project, displaying both the titles and the
names of the objects (in parentheses).

Bl Add object from Master Design Yiew M=l Ed

taster View Device Objects

Inzomer protection and control (IMCORMERT] (] 4
Differential protection [IMCOMER 2]
Pratection and contral (OUT1) | Cancel I
Pratection and control [OUTZ) | I
Add Level
¥+
qz18.tiF

Fig. 3.10.-3 List of objects in Master Design View

Notice the Add Level button on the dialog. By clicking this button, you can add
Level objects to the user view for organizing the view's contents.

31




CAP 501 1MRS751900-MUM
User’s Guide
The intention is to add the objects OUT1 and OUT2 into this view. Select the object
named OUTI1 from the list and click OK to add the object closing the dialog. The
contents of the view should now be as shown in Fig. 3.10.-4.
B CAP 501 - Outgoing M=
File Edit “iews Swstem Toolz Help
ﬂ xl%l ﬁ | i,
Praoject Structure Object Toalz
%m ¥
B Protection and contral
| CACAPSO1YPRIN |
gs19_1
Fig. 3.10.-4 Object OUTI in place
Similarly, add the object named OUT?2 to this view.
Next, switch the view by selecting the Incoming menu item on the Views menu. Add
the remaining device objects INCOMER1 and INCOMER? to this view.
3.11. Launching object tools

32

Object tools are launched as follows:

1. Select the target device object in the project. Object tools are available in all
views of a project.

2. Double-click on the object tool on the Object Tools list or

3. Select the tool from the Object Tools list and press <Enter> on the keyboard.

The Project Structure Navigator allows a single object tool to be used at a time.
Documentation for each CAP 501 tool is supplied; the documentation is listed in the
Release Note.
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4.2.2.

Project Structure Navigator

About this chapter

This chapter describes the elements and functionality of the Project Structure
Navigator.

General

The Project Structure Navigator is your workspace for managing data and tools
during relay parametrization. It provides you with access to the CAP 501 tools and
project-based object-oriented data management.

Projects

In CAP 501, projects are the containers for object-oriented data management and
storage. Projects allow you to build representations of power stations and their
protection and control devices. The Project Structure Navigator supports the
maximum of 10 000 projects in the CAP 501 environment. In practice, the limit set
by the amount of available disk space is more likely to be encountered.

The Navigator allows you to build projects and operate these by means of a
hierarchical tree structure. The structure comprises of nodes where each node is an
instance of an object type. Initially, all projects are empty, meaning that the project
tree contains only one node (root level) that gives a starting point to build the project
upon.

The Project Structure Navigator works in one of two modes, the Master Design
View mode, or the User View mode.

Master Design View

The Master Design View allows insertion of all available object types in CAP 501.
It is the only view, in which you can:

* Insert objects to the project

* Configure the objects

» Configure the communication settings of the objects

The device objects are also available for use in the user views. The Master Design

View is a built-in view meaning that it is always available in every project and
cannot be deleted.

User Views

User views are intended for designing browsable operator views, e.g. for showing
only objects with importance to the user. The object hierarchy in a user view may
differ from the one in the Master Design View. Object types of the User Structure
object types group provide you with the means of arranging the hierarchy of user
views. The device objects, that are available in the Master Design View, can be
inserted into the user views.
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Object types

The Project Structure Navigator handles three types of objects:

Level object types

Device object types

Compound object types

Object type groups

Level object types function as structurization items in a
project. A level object type does not set restrictions on
what object types can be inserted underneath it. In many
respects, levels behave like directories in a file system
since directories may contain files and subdirectories. An
example of level object type is the Level type.

Device object types control physical devices. A device
object stores parameters about physical hardware, e.g. a
REF 541 terminal.

Compound object types combine the behaviour of level
and device object types. In a project, a compound object
has both object properties and structurization properties.
As the result, a compound object has private object
settings and a view level, under which it is possible to
insert objects of object types allowed by the object type.
The main difference between views of a level object type
and a compound object type is that compound object types
set restrictions on what object types can be represented in
its views. Examples of compound object types are plant
structures and communication gateways.

Each object type belongs to one named object type group, whose member types
provide common functionality.

Four object type groups are available:

User Structure

Plant Structure

Gateway

Protection & Control

Object types of this group serve the purpose of project
structurization. Contains level object types only.

Object types of this group serve the purpose of
MicroSCADA compatible project structurization.
Contains compound object types only.

Object types of this group serve the purpose of project
structurization and representation of communication
gateway devices. Contains compound object types only.

Object types of this group represent protection and control
devices. Contains device object types only.
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4.5.

User interface

Access to the various tools and functions is provided by means of a toolbar, menus
and keyboard shortcuts. Fig. 4.5.-1 illustrates the Navigator’s user interface and its
elements.

SR 3 CAP 501 - Master Design View
Menu bar ile Edit Views Swstern Tool: Help

=

Project Shuciune biect Toaoks
My Substaton + ay Setling Tool +
—reg My Statian Event Log Viewes
R My Bay
L=
% SPAD 346
+-=3 Anather Bay
=re M Level
L= REF 610
=ralle COM B10
~ REX 521

Toal bar

Ohject toolz

Structure

CACAPSOT\PRILOL | REFS4X Ann

psn_1

Fig. 4.5.-1 The user interface of the Project Structure Navigator

User interface elements

Caption bar Displays the name of the current view. In Fig. 4.5.-1, it is
the Master Design View. It also contains the standard
operating system’s window management commands for
minimizing, maximizing and closing the window.

Menu bar File, Edit, Views, System Tools and Help menu.

Tool bar The tool bar contains shortcuts for quick access to the
frequently used functions.

Object tools list An object selection sensitive list of object tools that are
available for the object currently selected in the project
structure.

Structure Displays the objects in the current project view for object

selection and navigation.

Status bar Displays the path of the current project and the type of the
object, currently selected in the project structure.
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The following icons are used for different object type groups in the project view:

Table 4.5.-1 Symbols for different object type groups:

=% |User Structure or Plant Structure

= Gateway

E = etc.|Protection & Control

Entering the Project Structure Navigator

To start CAP 501, select the shortcut “Start CAP 501 from the CAP 501 program
folder and press <Enter> or double-click the shortcut. This starts the MicroSCADA
service bringing up the Project Structure Navigator window.

Notice that if you attempt to start a second instance of CAP 501 which is not
allowed, you are notified that CAP 501 is already running (see Fig. 4.6.-1).

Ok

izt 2.t
Fig. 4.6.-1 Notification that CAP 501 is already running

Dismiss the notification by clicking OK.

File menu

The file menu contains the project handling functions and Exit.

LCloze Clrl+af
Organize Projects...

1 My Test
2oLz

3 Morthern Light
4QUICKSTART
5 Sost

E xit

File_menu

Fig. 4.7.-1 The File menu
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4.7.4.

4.7.5.

File Open
Keyboard entry: <Ctrl>+<0>

Tool bar entry:

=

By selecting this menu alternative, the currently open project is closed and the Open
Project dialog is opened.

Open Project

Project Mame: Project Dezcription:
CluickStart Prj

Open || Cancel I

oprj. kit
Fig 4.7.1.-1  The Open Project dialog

To open a project into the Navigator view, first select the project and then click
Open. This also enforces the project's system configuration, which you can view and
modify by means of the System Configuration Tool.

File Close

Keyboard entry: <Ctrl>+<W>

This alternative closes the currently open project.

Organize Projects

By selecting this alternative, the Project Export/Import Tool is started. For more
information on the tool, see Chapter 5. Project Export/Import Tool.

File History List

The File menu includes a file history list of the previously opened projects. It helps
to quickly open recently used local project.

The five last opened projects (if any) are listed and sorted so that the last used project
is the first name on the list. By clicking the project name or by entering the order
number, the currently open project is closed and the requested project is opened.
Exit

Keyboard entry: <Alt><F4>

By selecting this alternative, CAP 501 is closed and the MicroSCADA service is
stopped.
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Edit menu

The edit menu contains functions for adding and deleting objects and for invoking
the General Object Attributes dialog for the currently selected object.

Accessibility to the menu items depends on the currently selected object. For
instance, the Delete Object item in Fig. 4.8.-1 is disabled, indicating that the
currently selected object cannot be deleted.

- Inzert Object Inzert
Delete Object Del
Object Properties Alt+Return

Fig. 4.8.-1 The Edit menu

Insert Object
Keyboard entry: <Insert>

Tool bar entry:

-
g

E

By clicking this menu alternative you initiate the insertion of objects in the project.

Insert Object in the Master Design View

When you select the Insert Object function in the Master Design View, the Add
Project Object dialog (shown in Fig. 4.8.1.-1), appears on the screen allowing you
to specify the type of the object to be added to the currently selected location.

B Add Project Object X
Object type aroups: Object types:
IJzer Stucture
Plant Structure
[ ateway
Protection & Control
K2 K2
ok || cese |

gs1_1

Fig. 4.8.1.-1 Insertion of an object

The Project Structure Navigator displays all the object type groups currently
available in the CAP 501 environment. However, the object types of these groups
are filtered according to the currently selected object, which will host the new object.

To insert the object, first choose the appropriate object type group. Select the type
for the new object and click OK to enter the dialog, where you give the basic
properties for the new object (see Fig. 4.8.1.-2). Notice that this dialog varies
according to the type of the new object.
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Mew Object's Properties [_ |O]

Object Mame:
|
Object Title:

k. | Cancel
gnop. tif

Fig. 4.8.1.-2  Provide properties for the new object

Type in the title and the name for the object and click OK to complete its insertion.

If you omit the name, the Project Structure Navigator uses a

ﬂ generated name. You can change both of these properties later by
means of the General Object Attributes dialog. The title is a property
by which you will identify the object in the project views.

limited to a total of two hundred (200). One object instance can

reserve more than one STA object, so the actual maximum object
count in a project may be smaller than 200. If you try to add more
than 200 objects, the following notification dialog will be shown:

@ The maximum number of STA objects in a CAP 501 project is

Add Project Object x|
Cannot add object, the maximum S5TA object count has
been reached.
]
add_object AT

Fig. 4.8.1.-3  The limitation of project object instances is exceeded
Insert Object in the user views

When you select the Insert Object function in a user view, the ‘Add object from
Master Design View’ dialog appears on the screen, allowing you to select the object
to be added to the currently selected location.
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BH Add object from Master Design View Hi=] EE

b azter View Device Objects

|nzomer protection and control [INCOMERT] QK
Differential pratection [INCOMER 2]
Pratection and contral [OUT1) | Cancel I
Protection and control (DT 2] | I
Add Lewel
¥
aofnndy. i

Fig. 4.8.1.-4  Inserting a device object to a user view

To insert a device object, first choose it from the object list and click OK to close the
dialog.

All device objects that you have inserted in the Master Design View
ﬂ are available for selection. However, you can insert a device object
only once to a given user view.

This dialog also allows you to insert Level objects, which you can use for organizing
the contents of the user view. This is accomplished by clicking the Add Level button
(see Fig. 4.8.1.-4).

To insert a Level object, either select the root node of the view or another Level
object. Then, click Add Level to enter the dialog for providing the title of the object
(see Fig. 4.8.1.-5).

Add Level M=l
Object Title | Sta_1
ak. | Cancel I
ilo L kif

Fig. 4.8.1.-5  Inserting a Level object to a user view

Provide a unique title in the view's scope and click OK to close the dialog.

Delete Object
Keyboard entry: <Delete>

Toolbar entry:

@

To delete the currently selected object, use this function. You can delete only such
objects, which do not contain any subordinate objects.

If you are working in a user view, the deleted object remains in the project database
and it can thus be re-added to any user view in the project. However, deleting an
object from the Master Design View permanently removes the object from the
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project database, which in essence means erasing the object’s file storage from the
hard disk. Regarding device objects, deletion automatically causes the object to be
silently removed from any user views.

Object Properties

Keyboard entry: <Alt>+<Return>

Tool bar entry:

To bring up the General Object Attributes dialog for the currently selected object,
use this menu item.

Notice that if you select the root node, this function brings up the dialog for changing
and viewing properties of the project (in the Master Design View) or properties of a
user view (in a user view).

General Object Attributes dialog

The General Object Attributes dialog is a central tool for project object management.
The dialog contains two tabbed pages: General and Communication for setting/
viewing object's attributes. The General page is available for all objects in all views,
whereas the Communication page is displayed only in Master Design View for
objects that require communication settings. With the dialog's buttons, you invoke
the object's configuration dialog, if supported by the object type, and the dialog for
moving the object in the project hierarchy.

information on configuring the communication settings, refer to the
respective object type's configuration guide (e.g. the Tools for
Relays and Terminals manual.

ﬂ The Communication page is not documented here. For detailed
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General Object Attributes =]
General | Cormmurication I Ok
Object Title: Object Manie: | Cancel I
| Incomer protection and contral | IMCOMERT
Object Type: Wersion; Group: | Attributes. .
| REF54x 135 | Protection & Cantral T Move |
Remark.z: =
+*
+
qgoa.tif

Fig. 4.8.3.1.-1 The General Object Attributes dialog

Table 4.8.3.1-1 General Object Attributes dialog items

General page

Object Title

A read/write attribute in the Master Design View, read-only in user
views.

Object Name

A read/write attribute in the Master Design View, read-only In user
views.

Object Type

The type of the object, read-only in all views.

Version

The version of the object's type, read-only in all views.

Group

The group of the object's type, read-only in all views.

Remarks

Remarks on the object. A read/write attribute in the Master Design
View, read-only in user views.

Note! Data is automatically truncated to 253 characters without
notice.

Buttons

OK

Closes the dialog saving the changes to the object's general
attributes.

Cancel

Closes the dialog discarding the changes to the object's general
attributes.

Note! This button does not have any impact on changes to the
object's configuration.

Move

If the object's type supports moving objects, this button invokes the
dialog for moving the object within the current view. Otherwise this
button is disabled. For details on moving objects, see Section
4.8.3.2. Moving objects.

Attributes

Invokes the dialog for configuring the object. Enabled in Master
Design View only, on condition that the object's type supports object
configuration. Otherwise this button is disabled.
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4.9.

Moving objects

Objects can be moved only within the current view. The procedure involves using
the Move Object dialog (see Fig. 4.8.3.2.-1). The dialog is invoked using the
General Object Attributes dialog by means of the Move button, which is available
only if the currently selected object's type supports moving objects.

Move Object |

kaove the abject by choosing the view title in the
project structure.

REX |REX

| Maove Here I| Cancel I

rnabj. kif
Fig. 4.8.3.2.-1 The Move Object dialog

To move an object:

1. Select the object you intend to move.

2. From the Edit menu select Object Properties to open the General Object
Attributes dialog.

3. Click Move to open the Move Object dialog.

4. In the project structure, select the node, which will host the moved object.
Notice that you can work with the project tree in a normal manner, i.e. expand
and collapse nodes.

5. On the Move Object dialog, click Move Here to move the object. The Move
Object dialog closes causing the project structure to collapse. Notice that if the
Project Structure Navigator detects that the currently selected target node cannot
host the object you are about to move, you are not allowed to perform the move
operation. This means that clicking Move Here has no effect.

To cancel moving the object, click Cancel in the Move Object dialog.

Views menu

The Views menu contains view manipulation functions and the list of user views, if
such have been created in the current project. For example, in Fig. 4.9.-1 below, the
project contains one user view, titled User view 1.

Create Yiew
Delete Wiew
Wiews Properties

Mazter Design Wiew
|lzer wiew 1

Fig. 4.9.-1 The Views menu
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Create View

With this menu option it is possible to create new user views.

2 Project View Properties
Praject view file name: | CACAPSOT\PRJALOLAORBJ 0000M1 DVUE oK
Praoject view name: | User_1 Cancel

Project view description: | Usetview 1

Fioat narne: | ROOT

PR C Defakcolr @ Qwncobor: ([ [+

CrteView_

Fig. 4.9.1.-1  The Project View Properties dialog

New user views are created by defining the view name, that is the instance name,
and the view description that is a logical name for the view. The root name is the
name of the root node in the new view.

Different view colors can be used to differentiate projects and/or separate views of
a project. By clicking the button next to the "Own color" sample color box, a Color
Chooser dialog opens where you can select a color. The "Default color" option
reverts the view to the default light blue color.

3

B Project View Background Color,
File Edit Help

Color Mixer |5ystem Calarz I IJzer Calars I Semigraphic | Mamed Colors |

I

LI

[
I

] ENR|
Red | ) [ | s020 %) 3289
Green: | 1) [al¥ | 5020 %) 3209
Blue: | [ [0 [ 5020 %3283

Selected Calar
(. FGE: 32896, 32996, 32096

| 0k || Cancel || Apply l

ViewColors

Fig. 4.9.1.-2  Defining own view color
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4.9.3.

4.9.4.

4.10.

Delete View

This option deletes the current view. Only user views can be deleted meaning that
you can not delete the Master Design View.

View Properties

Select this option to view or change the current view’s properties.

B Pro ject Properties

X

Fraoject file narne: | C:ACAPROTAPRIMLOLAOB 0000SLAL M ] 4

Project name: |N|:|rthern Light | Cancel I

Froject description: | Pratection & Caontral

F oot name: | kodel Switchyard

Project view color: (@) Default color () Own color: J B

ViewProp_1
Fig. 4.9.3.-1  The Project Properties dialog
Project properties are the project name, that is the instance name, and the project

description that is a logical name for the project. The root name is the name of the
root node in the project view.

The background color for the view can be changed by clicking the button next to the
"Own color" sample color box. To change back to the default light blue color, select
the "Default color" option.

View List

The View List is a list of all views defined for the project. By selecting one of the
views, the navigator changes the active view. Only the Master Design View is
always available, user views are optional.

System Tools menu

The System Tools menu contains the tools that are available for use at the CAP 501
system level.

Swyztem Tools

Customize...

Sygtem Configuration
Plant Structure Settings
DR-Collector Tool

Fig. 4.10.-1 The System Tools menu

This menu is customizable. You can modify the contents of this menu by selecting
the Customize... option, see the next Section 4.10.1. Customize.... By default, menu
items for invoking the System Configuration Tool, Plant Structure Settings Tool and
the DR-Collector Tool are available.
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For detailed information on the System Configuration Tool, refer to Chapter 10.
System Configuration Tool.
For detailed information on the Plant Structure Settings Tool, refer to Chapter 6.
Plant Structure Settings.
For detailed information on the DR-Collector Tool, refer to the Tools for Relays and
Terminals manual.
4.10.1. Customize...
The Customize... menu alternative, see Fig. 4.10.1.-1, makes it possible to add and
remove tools to and from the System Tools menu.
Customize System Tool Menu =l E3
Systemn Toolz Men; Axailable Svztem Tools:
Systern Configuration r Close I DR-Collectar T ool x
Flant Structure Settings System Configuration
DR-Collectar Tool Plant Structure Settings
+ +
gtoolcust b
Fig. 4.10.1.-1 The Customization dialog
By selecting a system tool from the right hand list and clicking <<, the tool is added
to the System Tools menu. And by selecting a tool from the left hand list and
clicking Remove, the tool is removed from the System Tools menu.
4.11. Help menu
This menu contains the function for invoking the About dialog of the Project
Structure Navigator and CAP 501.
About Project Structure Mavigator
| &hout CAP 501 Fi
MHelp_1
Fig. 4.11.-1 The Help menu
4.111. About Project Structure Navigator
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This About dialog contains information about the current version of the Project
Structure Navigator and the Project Manager.
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4.11.2.

About CAP 501
Keyboard entry: <F1>
This About dialog contains information about the current version of CAP 501.
The information presented in the About CAP 501 dialog should be
Q available when contacting your local support. It can be copied to the

Windows clipboard in a textual format by clicking the Copy button
in the About dialog.
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5.1.

5.2.

Project Export/Import Tool

About this chapter
This chapter describes the Project Export/Import Tool.

General

The Project Export/Import Tool is used when a project is to be transferred to another
system or brought into your CAP 501 projects collection, which comprises all the
projects stored under the directory \CAP501\PRJ.

Starting the Project Export/Import Tool

The Project Export/Import Tool is started from the File menu by selecting Organize
Projects..., see Figure 4.2.-1.

F_OP.tif
Open... Chl+0
Cloze Chrl+af

Organize Projects...

| Esit AlteFe |

Fig. 5.2.-1 File menu with Organize projects...
The user interface of the Project Import/Export Tool is shown in Fig. 5.2.-2

Edproject Export/Import - C:\CAP501'Prj

APL/Project Mame: Project Dezcription:
CAPSOT /QuickStart QuickStart Prj 3 Clese
CAPS0T S ost

About PEIT...

Copy To...
Expart...
Import...

Properties...

Delete...

Duplicate. ..

Lreate...

Fig. 5.2.-2  The user interface of the Project Export/Import Tool
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(o]



CAP 501

1MRS751900-MUM

User’s Guide

5.3.
5.3.1.

50

Table 5.2.-1 presents the project-management functionality provided by the Project
Export/Import Tool (see also Fig. 5.2.-1.)

Table 5.2.-1 Description of the Project Export/Import dialog buttons:

Close For closing the dialog.

About PEIT... Provides additional information about the
tool and System Information.

Copy to... For copying projects.

Export... For exporting projects from the CAP 501

project collection to an arbitrary user-
defined location.

Import... For importing projects from an arbitrary
user-defined location to the CAP 501
project collection.

Properties... Provides information about the project
folder.

Delete... For deleting projects from the CAP 501
project collection.

Duplicate... For duplicating projects in the CAP 501
project collection.

Create... For creating projects in the CAP 501
project collection.

Source For defining the Project Source

Directory. It can be the computer you are
using or the MicroSCADA environment.

You can also define the path manually.

Features

Updating the project list

The operating principle of the Project Export/Import Tool is first to select a project
collection to the list view. The project list is updated by choosing the Source button
shown in Fig. 5.2.-2). The project list can be one of the following:

* Your CAP 501 project collection. By default, the project list displays this
selection.

* MicroSCADA application projects on a logical drive, either a local or a network
drive.

* Projects stored in an arbitrary user-specified directory.
The project list displays project names in the format APL/ProjectName. When APL

is CAP 501, it means that the project is in the CAP 501 project collection. Any other
APL indicates the MicroSCADA application and project name.

The Source button invokes the following dialog for choosing one of the alternatives
above:
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&4 Project Source Directory M=l
(@ CAPSOT On This Computer
1 MicroSCADA APL On Drive |
' Path |

] 4 Cancel I
pzd. bif

Fig. 5.3.1.-1  The Project Source Directory dialog

The MicroSCADA APL On Drive and the Path entries allow you to access both the
local and network computers.

To use the MicroSCADA APL On Drive option, specify the drive letter followed by
a colon (:), for example ‘R:’. The Path entry allows using the Universal Naming
Convention (UNC) file format in addition to the standard format:
<drive:>\<directory path>. Sample UNC entries are provided below:

Using a share name

\\WORKSTA\Backup\CAP501\Projects

where;
WORKSTA is the name of the target computer.
BACKUP is a share name on the target computer.

CAPS01\PROJECTS is a directory path under the share name.
Using the operating system’s administrative share name

\\WORKSTA\C$\Backup\CAP501\Projects

where;
WORKSTA is the name of the target computer.
C$ is the operating system’s administrative share name on the

target computer, the root directory of the drive C.

BACKUP\CAP501\PROJECTS'
is a directory path under the share name.
5.3.2. Project storage

Projects are stored in the PRJS directory in earlier CAP 501/505 releases, for
example:

<DRIVE:>\SC\CAP501\PRJS
In later CAP 501/505 releases they are stored in the PRJ directory, for example:
<DRIVE:>\CAP501\PRJ
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The MicroSCADA application projects are stored under the directory:
<DRIVE:>\SC\APL\aplname\PROTECTION\PRJ
where;

APLNAME is the name of the MicroSCADA application.

Copying projects between network computers

In network environments, projects can be copied from the local computer to/from
other computers in the network. Other computers are referred to by using their
computer name, which is a feature of the operating system. You should be granted
full access to the share name, if the intention is to copy projects to the network
computer’s project database collection.

The destination can be one of the following alternatives:

* The CAP 501 project collection on the local computer

* A MicroSCADA library application on a drive letter

* A network directory

* A MicroSCADA library application on a network computer

Notice that, it is up to you to verify before the project is copied that, object types and
tools in the project are compatible or equal on the remote system. If the project
contains objects of greater or foreign object types, the remote system may encounter
problems if the project contains object types of other versions than what is expected
by the object types and tools. Copying a project does not include the object types.

In Hot Stand-By systems (HSB) it is important that MicroSCADA is
@ shut down while the project is being copied.

When a project is copied to a MicroSCADA application, it is copied to the
application’s PROTECTION\PRIJ directory. For example, when the application is
named PKS, the destination would be \SC\APL\PKS\PROTECTION\PRJ. Since a
MicroSCADA library application can process one project only, it is named PRJ. For
example, when a project is copied from a CAP 501 project collection to a
MicroSCADA library application, it is renamed to PRJ during the copying process.

If a project already exists in the destination directory, you are prompted to replace
the project or abort the operation. Also, if you enter a destination directory which
actually is the same as the source directory, you will be notified that the copying
cannot continue.

Copy To... button brings up the Copy Project dialog (shown in Fig. 5.3.3.-1), for
choosing a destination for the selected project in the project list view.
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% Copy Project M= E3
Copy Project To:
(® CAPS01 on This Computer
) MicraSCADA APL on Diive B
1 Metwark Computer on SSComputersShare |
) MicraSCADA APL on Mebwaork SSCarmputersS hare |
MicroSCADA APL

N
(] I | Cancel I
copyp. tif

Fig. 5.3.3.-1  The Copy Project dialog

Enter the drive designation for the option MicroSCADA APL on Drive in format
<drive letter><colon>, for example ‘C:’. Use the letter of the drive on which
MicroSCADA has been installed.

Enter a network computer name in UNC format, for example “\L40017\MYPRJ".
In this example, the computer name is L40017 and MYPRJ is the share name. The
option MicroSCADA APL on Network \\Computer\Share refers to the APL
directory on the MicroSCADA computer, for example “\L40017\D_root\SC\APL".
Press <Enter> when your option is either MicroSCADA APL on Drive or
MicroSCADA APL on Network \Computer\Share to update the MicroSCADA
APL list with the desired MicroSCADA applications.

When you have selected the desired destination, click OK to copy the project to the
selected destination.

5.3.4. Choosing storage location for temporary projects

Temporary projects mean the compressed projects that have been exported from
CAP 501 or other product. It is recommended to save such projects in a special-
purpose directory outside the directory structure of CAP 501, for example
CA\EXPORTS.

Especially, avoid using the directory \CAPSO0I\TEMP for such
@ purpose, since the CAP 501 kernel may choose to erase its contents
at any time.

5.3.5. Exporting projects

Exporting a project means that all associated object entries in a project are
duplicated to some other location specified by you. The destination location can be
on the local system or on a network drive: the destination location is specified as a
directory path, for example C:\EXPORTS. The directory path must exist at the time
you issue the export command.
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The output result, in the specified directory, is a compressed archive file with the file
extension .AR. For example, if the project filename (which is also the actual
directory name for the project) is KRISTIINANKAUPUNKI, then the compressed
archive file name is truncated to KRISTIIN.AR.

used, although its compressed project filename is only eight (8)

ﬂ When the project is later imported, the full project name must be
characters in length.

The object types used in the project are not exported along with the project. Hence
the functionality in this sense is the same as with copying the projects, as described
in Section 5.3.3. Copying projects between network computers.

Eh Export Project il
Deztination directony:

ak | Cancel I
expp tif

Fig. 5.3.5.-1  The Export Project dialog

Importing projects

Importing a project is done in a similar way to exporting, except for the directory
entry: the source directory is the location from where the project is copied to your
project collection. The source directory can be a directory on your local computer
system or on a network drive. The directory entry must be the full directory path to
the project, for example C:\EXPORTS\KRISTIINANKAUPUNKI means that a
compressed project archive file KRISTIIN.AR is in the directory C:\EXPORTS.

Notice that the project must be specified using its complete project filename,
although its compressed archive filename is only eight (8) characters in length.

If the compressed archive was distributed to you on several diskettes, you must first
copy the contents of all the diskettes to a common directory on a hard disk drive and
import the project from there (see the note in Fig. 5.3.6.-1 below).

x

[ ate

In order to import an archive spanning multiple disks,
you muzt manually first copy all archive files bo a directan
an the hard dizk and impaort the archive from there.

Complete path to zource archive file:

Crhexpots\SOST AR

ak. | Cancel I
impp £f |

Fig. 5.3.6.-1  The Import Project dialog
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The complete filename path is the full path of the exported project archive. For
example, if a project DEMO was exported to directory X:\EXPORTS, then the
complete filename path would be X:\EXPORTS\DEMO.AR (if the drive letter X: is
mounted to the same location on both systems).

settings in the System Configuration and the object level addresses)
is preserved when the project is imported. If the communication
settings are obsolete or the current communication environment
differs too much from the source environment, the communication
settings of the project can later be reset from the System
Configuration dialog (see Section 3.8. System configuration in this
manual). The applicable settings are automatically converted, if the
source project is detected to have been exported from another
compatible tool product.

ﬂ The system configuration of the project (i.e. the communication

Project Export,/Import El

|mported project's communication settings can been later
rezet from the Sestem Configuration, if the communication
zetup iz obsalete.

Ok

impesrtif

Fig. 5.3.6.-2  The communication settings reset dialog

5.3.7. Project properties

The following dialog shows the filename of the selected project:

-gﬂ General Project Properties il

Project Filenarme;
| CACAPROTNPRINSOST

Cloze
proppr Tif

Fig. 5.3.7.-1  The General Project Properties dialog
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Deleting a project

Deleting a project is an irreversible operation that cannot be undone.

Project Export,/Impork 5[

& Are pou sure you want to delete the zelected project’?

Yes Hao I

delpr tif

Fig. 5.3.8.-1  Once you delete a project, you cannot undo it

Duplicating a project

Duplicating a project means that an exact copy of the selected project is copied to
your CAP 501 project collection. During the process of duplication, you can specify
a different project name and description. The project filename is actually a folder
name (directory name), which then will become the project’s home directory. The
project filename must not already exist.l

The Project Filename must be a single-word name without spaces or
ﬂ characters other than:
A through Z and

0 through 9

% Duplicate Project M=l E

Project Filename
| SO5TBAK

Project Mame:
| Sost

Project Description
| Backup of Sost

k. | Cancel
duppry. tif

Fig. 5.3.9.-1  The Duplicate Project dialog

Maximum length of the Project Filename is eight (8) characters.

Creating a new project

Creating a new project is done in a dialog similar to duplicating a project. The newly
created project is assigned an empty system configuration, i.e. no serial port
communication channels exist in the project's system configuration. Regarding
project creation, the same restrictions that apply to the project duplication apply also
here (see Section 5.3.9. Duplicating a project).
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5.3.11. Errors accessing remote disk resources

If you attempt to read/write access to a disk resource on a remote computer, which
does not contain matching MicroSCADA user account, you will receive error
notifications illustrated in Fig. 5.3.11.-1 and Fig. 5.3.11.-2.

Project Export/Import - E:ACAPS01APyj |

@ There iz a problem when acceszing the destination directany.

Either the destination does nat exizt ar the uger account is
denied zufficient rightz to perform CREATE and “WRITE
operationz.

1]

acc_denied.tif

Fig. 5.3.11.-1 Notification about a failed export operation

Project Export/Import - E-ACAPS01APr |

The project specified does nat exist or i=
inaccessible.

Ok

acc_denied?. tif

Fig. 5.3.11.-2  Notification about a failed import operation

The notification in Fig. 5.3.11.-2 appears on the screen also if the
ﬂ specified project does not exist.

In order to recover from such a situation, ensure that the target computer's
MicroSCADA user account is assigned the same password as your local computer.
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6.2.

6.3.

Plant Structure Settings

About this chapter
This chapter describes the functionality of the Plant Structure Settings Tool.

General

In order to be able to define the attributes for the plant structure object types that are
applicable to the whole project, this system level tool is available. This tool provides
the possibility to modify the predefined attributes and define the properties of the
undefined levels in the object type. For more information on the plant structure
object types, see Chapter 7. Plant Structure object types.

The lowest three levels are disabled because there are no use for them in the CAP
501/505 environment.

Starting the Plant Structure Settings Tool

Start the tool by selecting the Plant Structure Settings on the System Tools menu in
the Project Structure Navigator (see Fig. 6.2.-1).

Customize. ..

System Confi

DR-Caollector Toal

Fig. 6.2.-1 Starting the Plant Structure Settings Tool

Attributes of plant structures

The attributes of the plant structure are applicable to the whole project, i.e. there
cannot be several definitions of the plant structure’s attributes in the same project.

w Plant Structure Settings M= E
Flant Structure Levels
1 2 3 4 4]
| Level Id 574 | B | DEY | |
| Level Description | Station | B ay | Drevice | |
| Fild Length 10 |15 E | |
(] | Cancel I
pzz. i

Fig. 6.3.-1 Plant Structure Settings dialog
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The attributes that can be modified by means of this tool are:

* Level Id
* Level Description
* Field Length

These attributes are described in more detail in the following chapters.

The default values have been chosen on the basis of the corresponding functionality
in the MicroSCADA Network Control system.

It is not recommended to change the default values as it would
@ probably cause compatibility problems when e.g. exporting projects
to MicroSCADA.

Level Id

The Level Id attribute defines what the identifier is for recognizing a certain level in
a plant structure.

The defaults are:
» STA that is used for recognizing station level objects

* BAY that is used for recognizing bay level objects

* DEV that is used for recognizing device level objects

Level Description

The Level Description attribute is used for describing the different levels in the Add
Object dialog, when an object is inserted.

The defaults are:
« Station

* Bay

* Device

Field Length

The Field Length attribute defines the maximum possible length of the instances’
names, when adding an object of the plant structure type to the project.

The defaults are:
* 10
* 15
5
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7.2,

7.3.

7.4.

Plant Structure object types

About this chapter
This chapter describes the object types included in the plant structure object group.

Overview

The Plant Structure object types are intended to be used, when building
MicroSCADA compatible project structures. It is possible to define five structure
levels, although three of them are predefined. For more information on structure
level definition, see Chapter 6. Plant Structure Settings.

General

The plant structure object types are level sensitive. This means that it is only possible
to insert predefined objects under each level of the structure. For example, it is not
possible to insert a bay object under the root level, while it is possible under the
station level.

Field length

The length of the instance name in the Plant Structure object type is restricted to the
value defined for the level in the Plant Structure Settings. See Chapter 7. Plant
Structure object types for more information.

Add Project Object |

& The magimurm number of characters inthe id iz

exceeded. The maximumn character length iz 10

OF.

M atif M arme. tif

Fig. 7.3.-1 Notification about the instance name length

If the instance name is longer than defined in the Plant Structure Settings, the
notification shown in Fig. 7.3.-1 appears on the screen. When this happens, the
correct thing to do is to shorten the instance name to the maximum number of
characters indicated by the notification.

Station

The station level is intended to be used in conjunction with a subsequent bay level.
Highlight the project's root node and select Insert Object from the Edit menu to open
the Add Project Object dialog (see Fig. 7.4.-1).
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Add Project Dbject
Object Tupe Groups: Object Tyupes:

I1zer Structure Statian
Plant Structure

Pratection & Cantral

ok || oo |

add_plant_ztruc_zta tif

Fig. 7.4.-1 Adding a station level object

Insert the station object by selecting the Plant Structure object group and the Station
object type. Then, click OK to open the station level object dialog (see Fig. 7.4.-2).

(Notice that in the Project Structure Navigator's status bar, the displayed object type
is Ol for objects of type Station).

Add Plant Structure Object - Station

Farent Object: | Fioat

Plant Structure Object |

Object Name: The maximunm number of characters for the
| Statiorn_1 object name iz 10

Object Title:

| Subztation

0k, Cancel I
addzta. bif|

Fig. 7.4.-2 Adding a Station level object

Type in an appropriate name and title for the object and click OK to have the station
level object inserted.

The name of the object identifies the unique instance as the structure is built up. The
instance name length is restricted to the number of characters defined in the Plant
Structure Settings. The maximum length of the name is also displayed on the dialog.

The title of the object is a symbolic description and it is visible in the Project
Structure Navigator.
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Bay

Highlight a station level object of a Plant Structure and select Insert Object from the
Edit menu to open the Add Project Object dialog (see Fig. 7.5.-1).

Add Project Object | x|

Object Type Groups: Object Types:
Flant Stucture Bay
(] Cl
add_plant_ztruc_bay. tif | et I

Fig. 7.5.-1 Adding a Bay level object

Insert the bay object by selecting the Plant Structure object group and the Bay object
type. Then, click OK to open the bay level object dialog box (see Fig. 7.5.-2).

(Notice that in the Project Structure Navigator's status bar, the displayed object type
is OI for objects of Bay type).

Add Plant Structure Object - Bay |

Parent Object: | 0B.J0003

Plant Structure Object |

Object Name: The maxirmum nurmber of characters for the
| Bay 1 object name iz 15

Object Title:
| Bap®

0k, Caricel I
addbay. if

Fig. 7.5.-2 Adding a Bay level object

Type in an appropriate name and title for the object. Then, click OK to have the bay
level object inserted.

The name of the object identifies the unique instance in the structure. The instance
name length is restricted to the number of characters defined in the Plant Structure
Settings. The maximum length of the name is also displayed on the dialog.

The title of the object is a symbolic description and it is visible in the Project
Structure Navigator.
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8.1.

8.2.

8.2.1.

User Structure object types

About this chapter

This chapter describes the object types included in the User Structure object group.

Overview

User Structure object types are intended to serve as structurization objects for
structures that have some other structurization requirements than MicroSCADA
compatibility. The level structure can be built as deep as is required for the purpose
intended.

General

The User Structure object types can be used both in the Master Design View and in
the user views.

The main difference between the User Structure object types and the Plant Structure
object types is that the User Structure does not have the guided insertion order,
which means that the levels and their purposes are defined by the user.

Inserting Level objects

Highlight a level object and select Insert Object from the Edit menu to open the Add
Project Object dialog shown in Fig. 8.2.1.-1. Notice that in every view, the root node
is also a Level object.

Add Project Object

Object Type Groups: Object Types:
I1zer Struchure Level - Level n
Plant Structure
Pratection & Cantral
¥
ok || cese |

add_uzer_stouc_ vl b

Fig. 8.2.1.-1  Adding a User Structure object

To insert the level object, select the User Structure object group and then the Level
object type. Click OK to open the Add Level dialog shown in Fig. 8.2.1.-2.

Add Level H=] E3

Object Title | User Leve!

0k, | Caricel
adduzohi. kif

Fig. 8.2.1.-2  Adding a Level object
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Enter a title for the object and click OK to insert it into the tree structure. The title is
visible in the Project Structure Navigator and it must be unique in the scope of its
view, i.e. you cannot have two Level objects having the same title in a single view.
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9.1.

9.2

Gateway object types (COM 610)

CAP 501 supports the following gateway:

* COM 610 communication gateway

General

In CAP 501, the COM 610 communication gateway can be used as a SPA router for
the following relays and terminals:

* RED 500 series
* SPACOM family

Being a communication gateway, the task of COM 610 is to make protocol
conversions between process communication and remote communication. The
protocol used in process communication is called the master protocol (protocol
between COM 610 and the relay/terminal), and the protocol used in remote
communication is called the slave protocol (protocol between CAP 501 and COM
610). In general, the master protocol can be selected irrespective of the selected
slave protocol.

For the protocol conversions to be possible, cross-references between different
protocols must be done with the engineering tools provided by COM 610. The
engineering also includes mapping of the protocol addresses.

gateway itself is not described here. The documentation and tools

ﬂ Installation, configuration and usage of a COM 610 communication
delivered with the gateway must be utilized.

Supported protocols

The following master/slave protocols supported by COM 610 can be used in CAP
501.

Slave protocol:

* A COM 610 object can be connected to CAP 501 via a SPA router or a SPA TCP/
IP protocol.

Master protocols:
* A COM 610 object allows SPA or SPA TCP/IP protocols to be defined as the
master protocol for the RED 500 series.

* A COM 610 object allows SPA or SPA TCP/IP protocols to be defined as the
master protocol for the SPACOM family.

400/402 Ethernet adapter and an IEC 61850 OPC server in COM

ﬂ The SPA TCP/IP master protocol refers to the usage of a SPA-ZC
610.
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9.3. Insertion
Adding and using a COM 610 object in a CAP 501 project is not
ﬂ mandatory. The device objects can be added to the project with or
without a COM 610 object, if defining the device communication
settings properly.
COM 610 objects can be inserted only in the Master Design View mode of the
Project Structure Navigator, and cannot be used in a project's user views. However,
the device objects hosted by a COM 610 object are normally visible also in the user
views.
You can insert COM 610 objects into the following locations of a project:
« under the root node of the project
* under a Station object
 under a Bay object
* under a Level object
In contrast to other objects, COM 610 objects are non-movable. This means that
once inserted, a COM 610 object cannot be moved elsewhere in the tree structure.
The modifiable attributes of COM 610 objects are the same as for the other object
types (see Fig. 9.3.-1).
E General Object Attributes |z|
General |Eummunicatinn |
Object title: Object name: _Eanu:el
| COM 10 | COME10_T -
|EI bject ype: Wersion; |I3r|:|u|:|:
COMED 1.00 Gateway
Remarks:
Optional infarmation can be inserted here. *
+
Gen_Obj_Attr
Fig. 9.3.-1 General object attributes for COM 610 objects
9.4. Communication settings
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Due to the nature of a communication gateway usage, the communication settings
for both the master and the slave protocol must be defined separately. These settings
together define the complete communication settings of a single relay/terminal.
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9.4.1.

9.4.1.1.

9.4.1.2.

Since the cross-reference tables between the master and slave protocols must have
been done for COM 610, also the protocol addresses are mapped. In other words, the
SPA address of a relay/terminal to be used in CAP 501 is not necessarily the same
as defined in the physical relay/terminal.

ﬂ SPA addresses behind a COM 610 object must be unique in CAP
501.

Communication settings of COM 610 object

The communication settings of the COM 610 object can be configured only if the
project's system configuration contains one or more serial ports or TCP connections.

The communication settings of COM 610 objects are configured on the
Communication page of the General Object Attributes dialog in the Project Structure
Navigator (see Fig. 9.4.1.1.-1 and Fig. 9.4.1.2.-1).

SPA protocol settings of COM 610 object

When the SPA protocol is used to connect the COM 610 to CAP 501, the only
required definition is the serial port to be used. The SPA address is not applicable
for the gateway itself.

P General Object Attributes

3
Genesal |Cm-mnu:atmn| oK
Pratocok Cancel
[sPa [2] |_system Configuaton.._| (b
: Attnbistes. .
Serial port: SPA addiess: . dove
- =

SPA_pro_settings

Fig. 9.4.1.1.-1 SPA protocol settings for COM 610 objects

SPA TCPI/IP protocol settings of COM 610 object

When the SPA TCP/IP protocol is used to connect COM 610 to CAP 501, two
definitions are required:

» TCP connection on the local computer to be used
¢ [P address of the COM 610 gateway

The SPA address is not applicable for the gateway itself.
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_! General Object Attributes ‘F
General |Emlm.nu:aﬁnnl ok
Protacok Cancel
[sPa TCPAP [3] | swstem Configuration.. |
Abtnbutes.
Local connechion: T
| I|:P"| |Ei MOYE,,,
IF address: SPA address
|132168.210 |
SPA_TC_IP_settings
Fig. 9.4.1.2.-1 SPA TCP/IP protocol settings for COM 610 objects
9.4.2. Communication settings of device object
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The communication settings of the device object can be configured only if the parent
COM 610 object's communication settings have been defined first.

The communication settings of device objects are configured on the Communication
page of the General Object Attributes dialog in the Project Structure Navigator (see
Fig. 9.4.2.-1).

E General Object Attributes

X

General | Eummuni-::atiunl
Protocaol:
|SF'.¢3. |£| | Suztem Configuration. .. I

Serial part: SP address:

|N£ﬁ |£| |54

Comm_settings_2

Fig. 9.4.2.-1  Communication settings for RED 500 series terminal with COM
610 as master.
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9.5.

Irrespective of the protocol to be selected (SPA or SPA TCP/IP), the only required
definition is the SPA address. Other port/connection/address definitions are not
applicable for the device objects connected to COM 610.

Address mappings between CAP 501 and COM 610 are based on
ﬂ SPA addresses with all the master protocols.

Using COM 610 object
Here is an example of a configured COM 610 object:

B CAP 501 - Master Design View
File Edit “iews Svstem Toolz Help

Froject Stucture Object Toolz

| Relay Setting Tool +
Event Log Viewer

C:ACARSMAPRIN | RECS 'l“llnﬂ

Fig. 9.5.-1 COM 610 object hosting a REC52X object
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10.

10.1.

10.2.

10.3.

10.4.

10.4.1.

10.4.2.

System Configuration Tool

General

The System Configuration Tool is intended for setting up the project's system
configuration, to enable communication with the relays in CAP 501. Every project
has its own copy of the system configuration, which is enforced when the project is
opened into the Project Structure Navigator. Likewise, when a project is closed, its
system configuration is stored with the project.

Target project

The System Configuration Tool automatically edits the system configuration of the
project that is being opened into the Project Structure Navigator. If there is no
project open in the Project Structure Navigator, the System Configuration Tool will
not execute.

Communication protocol support
Supported communication protocols are:

* SPA
* SPA TCP/IP

Serial port configuration

Serial ports

Each serial port defined for use in CAP 501 must also exist at the operating system
level. For example, if you define serial ports COM1 through COM4 in CAP 501, you
must also define them under the operating system. For detailed information on
configuring the serial ports under the operating system, refer to the Windows Help
or other applicable source of information.

CAP 501 supports a total of 8 serial ports (COM1 through COMS) in a system
configuration.
Advanced serial port settings

Advanced serial port settings are defined only at the operating system level.
Therefore, you do not have to define them in CAP 501. These settings include:

* Interrupt request line (IRQ)
* Input/output (I/O) addresses
* Data buffering settings
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10.5.

10.6.
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Basic serial port settings

The basic serial port settings that are defined at the operating system level are
overridden by the settings you specify in CAP 501. These settings include:

* Baud rate
* Data bits
* Parity

* Stop bits

Using USB ports

In order to utilize a USB port with CAP 501, you need to use a USB to serial adapter.
You also need to install the driver software for it (this software is distributed by the
adapter). The adapter can be set to a serial port in the range within COM 1 to COM
8. You need to check your operating system setup for a free COM-port.

In the CAP 501 system configuration setting of serial port you select the serial port
you have assigned to be provided by the converter. No further settings are required
in CAP 501 for using a USB port since the USB looks to a serial adapter like a
genuine serial port to CAP 501. USB ports are not applicable in Windows NT.

SPA TCP/IP communication

Using the SPA TCP/IP protocol requires an Ethernet network adapter to be installed
on the computer. It can be any device supported by the operating system. For
detailed information on configuring the network adapters under the operating
system, refer to the operating system Help or other applicable source of information.

Using the network adapter in CAP 501 does not require any additional installation
or configuration in addition to the definitions made in CAP 501 System
Configuration Tool.

Starting
In order to access this tool, two entry points are provided:

 System Tools menu in the Project Structure Navigator
* The Communication page of the General Object Attributes dialog

The System Configuration Tool edits the system configuration of the project that is
currently being opened into the Project Structure Navigator. If there is no project
opened in the Project Structure Navigator, the System Configuration Tool refuses to
execute.
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10.7.

System Configuration Tool dialog
The System Configuration Tool dialog is shown in Fig. 10.7.-1.

-ZSystem Configuration

Communication |

ok

Senal Ports

SPATCPAP |
Carcel

-

IEEEE El= I

Apply
Delete

Protocal;

Connection bpe;

todem cormmard (ST ):

Baud rate:

Farity:

|
|
|
D ata bits: |
|
|

Stop bits:

Header timeout; < Advanced

| Beszet Communication Settings I

syscnf_dialog
Fig. 10.7.-1 System Configuration Tool dialog

The Communication page contains two pages:

* Serial Ports

» SPA TCP/IP

Table 10.7.-1 System Configuration Tool items

Communication configuration pages

Serial Ports For managing serial port configuration, see Section 10.7.1. Serial Ports
page.

SPA TCP/IP For managing the SPA TCP/IP configuration, see Section 10.7.2. SPA
TCP/IP page.

Communication configuration buttons

Reset For resetting the communication settings, see Section 10.9. Resetting
Communication |communication settings.
Settings
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Table 10.7.-1 System Configuration Tool items

Common dialog buttons

OK For closing the System Configuration Tool and saving the configuration.
For more information, see Section 10.8.1. Save configuration - close tool.
Cancel For closing the System Configuration Tool without saving the

configuration. For more information, see Section 10.8.3. Discard
configuration changes.

Apply For saving the configuration without closing the System Configuration
Tool. For more information, see Section 10.8.2. Save configuration -
proceed configuration.

10.7.1. Serial Ports page

Fig. 10.7.1.-1 displays the Serial Ports page of the System Configuration Tool.
Initially the configuration is empty, as illustrated in the figure below.

‘£ System Configuration

Communication |

K.
Serial Ports |SF'.¢‘-. TCFAR |

&pply
Delete

Pratacal;

Connection type:

blodem command [AT]:

Braud rate:

[rata bitz:

Parity:

Stop bitz:

Header timeaut; < Advanced

| Bezet Communication Settingz I

IEEEE == I

syscnf_dialog

Fig. 10.7.1.-1 The Serial Ports page
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Table 10.7.1-1 Serial Ports page items

Serial Ports page items

Serial Ports For selecting a serial port. Displays all the currently defined serial
ports.

Protocol For assigning the communication protocol to the currently selected
serial port.

Connection type This list is not used in CAP 501 and is always disabled.

Modem command |This field is not used in CAP 501 and is always disabled.

(AT)

Baud rate For assigning the baud rate to the currently selected serial port.

Data bits For assigning the data bits setting to the currently selected serial port.

Parity For assigning the parity setting to the currently selected serial port.

Stop bits For assigning the stop bits setting to the currently selected serial port.

Header timeout Field for defining the Header Timeout attribute for the currently
selected serial port. Enabled only after clicking the "<Advanced"
button.

< Advanced button |For enabling the editing of the Header timeout field.

Add ... button For adding a new serial port. For more information, see Section
10.7.1.1. Serial ports - Adding.

Delete button For deleting the currently selected serial port. For more information,
see Section 10.7.1.3. Serial ports - Deleting

10.7.1.1.

Serial ports - Adding
To add a serial port:

1. Click Add ... to bring up the dialog shown in Fig. 10.7.1.1.-1.

2. Enter the serial port number, which must be in range of 1 through 8. If you enter
an out-of-range value, or a value which is already in use, you are requested to
enter a proper value.

Add serial port

[nput port number

|

0k, | Cancel
add_zerial_pork ki

Fig. 10.7.1.1.-1 Define the port number for the new COM port

3. Click OK to add the new port, which appears in the Serial Ports list (see
Fig. 10.7.1.1.-2). Otherwise, click Cancel to keep the configuration unchanged.
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-E System Configuration

Communication |

Serial Ports |SF'.-'1'-. TCRAF |

COm1

I=
[l
[l

IEEEE 1] [i«] II

Delete

€ B

Frotocal;
SPa

Connection type: | Diirect

kodem command [T |

Baud rate: | 3600
Drata bits: | 7
Parity: | Ewven
Stop bits: | 1

Header himeaut;

1200 < Advanced

| Bezet Communication Settings I

O

Cancel

Apply

new_port_1

Fig. 10.7.1.1.-2 A new serial port COM1 added with default values

The newly added port's basic settings and communication protocol are assigned
default values. If you wish to use other than the default values, you can configure

them as described below.

Serial ports - Configuring

The following table displays serial port properties, which you can configure on a

per-serial port basis.

Table 10.7.1.2-1 Configurable properties of serial ports.

Property Available values

Protocol SPA

Connection type Direct

Baud rate 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600
Data bits 5,6,7,8

Parity None, Odd, Even

Stop bits 1,2

Header timeout 0 - 65535 (ms)
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To configure a serial port property:

1. Select the serial port from the Serial Ports list.

2. Configure the item by selecting the desired value from the appropriate list or by
entering the value manually.

The Header Timeout attribute of the SPA lines defines the maximum waiting time
in milliseconds within which the first byte of a response from the slave should be
received after the transmission of a message. By default, the "Header timeout" field
is disabled to indicate that normally the value should not be modified. When the
"<Advanced" button is clicked, a warning message is shown before the value can be
changed. The default value for a direct SPA connection is 1200 ms.

Serial ports - Deleting

Any serial port, defined in a project's system configuration, can be deleted at any
time.

To delete a serial port from the configuration:

1. Select the serial port from the Serial Ports list.

2. Click Delete ....
3. When prompted to confirm the deletion, click Yes to delete the serial port (see
Fig. 10.7.1.3.-1). Otherwise click No to leave the serial port intact.

System Configuration E

Deleting the port COM3F invalidates communication settings
for thoze objects that are curently configured to
communicate via it Are you sure you want to delete this
port?

Yes Mo I

zc_delp. b

Fig. 10.7.1.3.-1 Confirm to delete the selected serial port

The deletion invalidates the communication settings of any device objects, which
has been configured to use the port you are about delete.

saved system configuration by clicking Cancel (see Section 10.8.3.

ﬂ If you accidentally delete ports, you can revert to the most recently
Discard configuration changes).
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SPA TCP/IP page

The SPA TCP/IP page of the System Configuration Tool is shown in Fig. 10.7.2.-1.
Initially the configuration is empty, as illustrated.

-CSystem Configuration

Communication |

Serial Ports | SPA TEF"J'IF"'

ok

Cancel

— Local IP address

&pply

I}
(=
=5

Delete

(@ Obtain IP address automatically
1 Usze following 1P address: | 123456789

— Header tirmeaut

Beset Communication Settings I

SPA_TCP_IP

Fig. 10.7.2.-1 The SPA TCP/IP page

Table 10.7.2-1 SPA TCP/IP page items

TCP connections

List for selecting a TCP connection port. Displays all the
currently defined TCP connections.

Local IP address

Selection of the IP address for the currently selected TCP
connection

Header timeout

Field for defining the Header Timeout attribute for the currently
selected TCP connection. Enabled only after clicking the
"<Advanced" button.

< Advanced button

For enabling the editing of the Header timeout field.

Add... button

For adding a new TCP connection, see Section 10.7.2.1. TCP
connections - Adding

Delete button

For deleting the currently selected TCP connection, see
Section 10.7.2.3. TCP connections - Deleting.
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10.7.2.1.

10.7.2.2.

TCP connections - Adding

To add a TCP connection just click the Add... button. A new TCP connection with
automatic numbering is added to the TCP connections list.

-E System Configuration

Communication

Serisl Ports | SPA TEP!IF'

Cancel

4dd

Delete

— Local IP addrezs

(® Obtain IP address autamatically
1 Use following IP address: | 12345 67.89

— Header timeout

2000

Beszet Communication Settings I

TCP_conn_added

Fig. 10.7.2.1.-1 A new TCP connection TCP1 added with default values

Default values are assigned to the newly added connection. If you wish to use other
than the default values, you can configure them as described below.

TCP connections - Configuring

The following properties can be configured by first selecting the desired TCP
connection from the list.

Local IP address

The Local IP address is the IP address of the CAP 501 computer. It can be either
manually given or automatically solved. The only reason for giving the IP address
manually is the case when the computer has multiple IP addresses, and one of those
is specified.
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By selecting the default "Obtain [P address automatically” option, the address of the
computer needs not to be specified. By selecting the "Use following IP address"
option and entering the IP address field, a dialog for typing the address is opened:

‘L Local IP Address

IJze following IF address:
123456783

k. | Cancel I

Local_IP_address

Fig. 10.7.2.2.-1 Input dialog for local IP address
Header timeout

The Header Timeout attribute of the SPA lines defines the maximum waiting time
in milliseconds within which the first byte of a response from the slave should be
received after the transmission of a message.

By default, the "Header timeout" field is disabled to indicate that normally the value
should not be modified. When the "< Advanced" button is clicked, a warning
message is shown before the value can be changed.

The default value for a TCP connection is 2000 ms (accepted range is 0-65535). The
value should be increased if there are long communication delays in the TCP/IP
network.

TCP connections - Deleting

Any TCP connection, defined in a project’s system configuration, can be deleted at
any time.

To delete a TCP connection from the configuration:

1. Select the TCP connection from the TCP connections list.

2. Click the Delete button.
3. When prompted to confirm the deletion, click Yes to delete the connection (see
Fig. 10.7.2.3.-1). Otherwise, click No to leave the TCP connection intact.

System Configuration §|

geftings for those objects that are cumently configured to
communicate via it Are you sure you want to delete this
connection?

& Deleting the connection TCP3 invalidates communication

Delete_TCP_conn

Fig. 10.7.2.3.-1 Confirmation to delete the selected TCP connection
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10.8.1.

10.8.2.

The deletion invalidates the communication settings of any device objects which
have been configured to use the connection you are about delete.

System configuration - save

The project's system configuration is saved permanently by using either the OK or
the Apply button. The difference is that the OK button closes the System
Configuration Tool, whereas the Apply button allows you to proceed working with
the tool. The tool also provides you with the possibility to revert to the most recently
saved configuration in order to prevent accidental changes to the configuration (see
Section 10.8.3. Discard configuration changes).

Save configuration - close tool

To save the changed configuration, closing the System Configuration Tool, click
OK. The System Configuration Tool prompts you to confirm the operation (see
Fig. 10.8.1.-1).

System Configuration Ed |

The communication settings have been changed. Click Yes
to permanently zave the configuration, click Mo to revert to
the oniginal configuration.

es | Mo I

zo_ok. kif

Fig. 10.8.1.-1 Confirm to save the configuration

To save the configuration, click Yes. Clicking No enforces the most recently saved
configuration.

Save configuration - proceed configuration

To save a changed configuration without closing the System Configuration Tool,
click Apply. The System Configuration Tool prompts you to confirm the operation
(see Fig. 10.8.2.-1).

System Configuration E |

The communication settings hawve been changed. Click Yes
ko permanently zave the configuration, click Ma ta revert to
the ariginal configuration.

Yes | Mo I

zc_ ok hf

Fig. 10.8.2.-1 Confirm to save the configuration
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To save the configuration, click Yes and the configuration becomes the most
recently saved configuration. Otherwise click No to proceed without saving.

Discard configuration changes

To revert to the most recently saved configuration, click Cancel. This closes the
System Configuration Tool without further notifications.

Resetting communication settings

The communication settings of the project can be reset from the System
Configuration dialog. Resetting means clearing the communication settings (done in
the System Configuration) as well as all the object level communication addresses.
The main purpose of this function is to reset the obsolete communication setup of an
imported project. The System Configuration dialog prompts you to confirm the
operation (see Fig. 10.9.-1).

"8 system Configuration x|

The purpose of thiz funchion iz to rezet the
obsolete communication setup of an imported
praoject.

Rezet Communication Settings removes all the
zettings done an the Communication page for the
curment project, and alzo the communication
addreszes on the device object level. Thiz
function does not change zettings of any
hardware.

To be able to communicate with the devices all
theze project and object level settings have to be
re-entered after uzing this function.

Are pou sure you want to rezet the communication
zettings?

Yes Hao I

reset_sys_conf tif

Fig. 10.9.-1 The communication settings reset dialog

To reset the communication settings, click Yes. Clicking No cancels the operation.

After accepting to reset the settings, the deleted system configuration

@ cannot be retrieved by clicking the Cancel button of the System
Configuration dialog. Also, to be able to communicate with the
connected devices again, all the communication settings must be re-
entered.
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